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Contributors
Behind the Nest system are the collective efforts of many people primarily at the Baltic Nest Institute
(BNI) now part of the Stockholm University Baltic Sea Centre. Alexander Sokolov has designed and
developed all the program interfaces of Nest. Oleg Savchuk, together with Fredrik Wulff, has
developed the marine model SANBALTS. Bo Gustafsson, Oleg Savchuk and Bärbel Müller-Karulis are
the key developers of the BALTSEM marine model. Carl-Magnus Mörth, together with Christoph
Humborg, have initiated and developed the drainage basin model CSIM. Chris Harvey, Olle Hjerne and
Sture Hansson (at the department of Ecology, Environment and Plant Sciences, SU) developed the
fishery model and Ing-Marie Gren (at the department of Economy, SLU) developed the costminimization model.

The marine and riverine nutrient load databases were initiated by Fred Wulff and are maintained by
Miguel Rodrigues Medina. The marine databases are now to a great extent a common product of many
research organizations around the Baltic, thanks to the remote access to regional databases developed
by Alexander Sokolov. He has also developed the remote access to the databases and models of
atmospheric deposition of nutrients of EMEP (Jerzy Bartnicki) and DEHM (Kaj Hansen Mantzius).
Christoph Humborg initiated the drainage basin database, developed and maintained by Erik
Smedberg. But the Nest system is truly a collective effort and many people within and outside BNI
have contributed with data and ideas.

The Baltic Sea, an ecosystem under pressure
Input of nutrients like nitrogen (N) and phosphorus (P) to the sea is a prerequisite for life, not an environmental problem. It becomes a problem only when the inputs increase to such an extent that the
original properties or functions of the ecosystem change. Then it has become “too much of a good
thing”. When this happens in a marine area or a lake we refer to it as eutrophication. The natural cycle
of accumulation and decomposition are no longer in reasonable balance. The semi-enclosed and
brackish-water Baltic Sea is in many respects particularly sensitive to eutrophication, with its slow
water exchange and built-in natural barriers.
Measures taken by many countries during the last decades have reduced total loads of both N and P,
but loads still remain higher than needed if eutrophication is to be reduced to an acceptable state.
Eutrophication continues to be a priority environmental problem of major concern in the Baltic Sea
Region. There are several reasons behind this. A large proportion of the total load of waterborne and
airborne nutrients to the Sea originates from diffuse sources; such as agriculture, a sector where
national legislation is not as efficient as for point sources from municipalities and industries. Still,
many measures to counteract eutrophication need to be implemented. There are also considerable
time delays between measures taken in a drainage basin and detectable reductions in inputs of
nutrients to the Sea. The long residence time of nutrients in the sea basins (many years) means that
outputs from one region are likely to affect other regions. The open coastal zones are affected not only
by nutrient inputs from land, but also from the open sea and, thus, also by transports from other
basins.
The dramatic changes of the ecosystem that we have seen during the last century have multiple
causes. Eutrophication and fisheries are intimately linked. Climate changes, the establishment of new
species in this young sea and the effect of persistent toxic substances are other factors. In order to
develop management strategies for any ecosystem, it is important to understand the relative
importance of different factors causing change.

Since the effects of eutrophication are the result of nutrient transports and transformations in a
number of interlinked systems, management without understanding the links between the systems is
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likely to result in more costly mitigation programs than necessary. An ecosystem approach is needed.
Although our understanding of the Baltic is considerable, it is highly fragmented and there is a need to
utilize and synthesize scientific information pertinent to the relevant problem and management scale.
A common language for communication between scientists and managers, and a consensus about
scales, problems and causes, needs to be established. Such a holistic approach must take into account
not only characteristics of the sea but also of the surrounding drainage basin. An understanding of
human behavior and how man influence the sea is also an integral component of an ecosystem
approach. The decision support system Nest has been developed as a tool to synthesize our current
understanding of the Baltic Region and as a tool for better management, particularly in relation to
eutrophication and fisheries.

The decision support system Nest
The decision support system Nest was initially developed within the MISTRA-funded MARE research
program (http://www.mare.su.se), which was completed in 2007. Nest was then successfully used for
the development of the eutrophication segment of the HELCOM Baltic Sea Action Plan (BSAP
http://www.helcom.fi/BSAP/ActionPlan/en_GB/ActionPlan/#eutrophication), where nutrient load
reductions needed to reach a healthy Baltic Sea were calculated, as were the allocations between
countries. Nest is also used in many research programs. The maintenance and further development of
Nest has continued within the Baltic Nest Institute (BNI, http://www.balticnest.org/).

The Nest system links the entire Baltic Sea region, from watershed to offshore ecosystems, through
data and models. It is available online, free of charge, and can be run in both expert and standard
mode. The main target groups of the Nest system are decision-makers and scientists in the Baltic
region interacting with the Helsinki Commission (HELCOM), as well as those working on the
implementation of the EU Water Framework Directive and Marine Strategy Framework Directive. We
also hope that it can be useful for students interested in learning more about the Baltic Sea. The
different components describe forcing by nutrient inputs and characteristics of the drainage and sea
basins. The marine models describe the physics and biogeochemistry of the Sea, as well as of its food
webs (to the levels of man and seals), and are used in scenarios of how fisheries, eutrophication, and
climate change affect this unique ecosystem. Finally, the strong interdependence of the countries
around the Baltic is illustrated when the costs for reducing nutrient load, with or without cooperation,
are calculated.
This manual is by no means the final version: it will be continuously improved and modified, both as a
result of user inputs and when components of Nest are modified. The most recent version of Nest, as
well as this manual, will always be available from our web site http://nest.su.se and
www.balticnest.org.
Nest has been designed as a web distributed system and to use it you need access to the Internet;
some components are installed on your (client) computer, others are installed on the servers that you
communicate with. Experts continuously update the components of Nest. Each time you start the
program, your client software is checked and updated if a new version is available. This procedure
ensures that you always use the most recent version of Nest.

How to get started – launching Nest

The Nest system is accessed through a special web page on the Internet site hosted by the Baltic Nest
Institute at Stockholm University. In order to launch and run Nest you need to have Java Virtual
Machine (JVM) installed on your computer, and accept that Nest gets access to your computer. In most
computer operating systems, Java is already preinstalled.
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If you do not have Java Virtual Machine installed you can click Installation in the right hand upper
corner of the Nest home page or just manually type in http://java.com and access the Java download
page. The Java software can be downloaded free of charge from this site. After installation you will be
able to start Nest from the Nest home page: http://apps.nest.su.se/nest
If you have Java installed, click Start Nest in the upper right corner of the Nest launch page. The
system will now start loading.

Here you can read about recent developments of Nest (News) and about program version and data
sources (About). You must agree on the terms of use (License) before you press Accept and the initial
window of Nest will appear.
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The Nest system contains several modules, which are grouped by environment and can be accessed
from the main menu bar (Atmosphere, Baltic Sea, Catchment etc.). The second row of the menu
provides tools for each module of Nest and can be different for different modules.
On the bottom of the window there is a signal line that provides some additional explanatory
information on the items over which you move the cursor of the mouse.

Most of the modules use GIS maps, which can be manipulated in a common usual ways (mouse scroll
to zoom in or out and mouse drag to move a map).
When Nest is open, you will first see the Atmospheric module of the system.
Atmosphere

About 25% of the nitrogen inputs to the Baltic Sea arrives via atmospheric deposition and is thus a
very important source. With this interface you can obtain data on atmospheric nitrogen and sulphur
emissions from- and depositions onto all countries and seas in Europe, with particular details for the
Baltic Region. These data are accessed via the Internet from the UNECE/EMEP databases hosted in
Oslo and Vienna and from the DEHM model in Denmark. You can also access ‘blame matrices’, with
which you can calculate how much of the depositions on a specific region originate from a particular
source/region or country. The other components are:

Baltic Sea
The Baltic Sea menu provides tools to explore a number of databases and models describing different
features of the sea:

7

Marine distributed databases
Here you can extract, view, and analyze the information about hydro-chemical conditions in the sea.
Measurements from many large databases located at various (research) institutes around the Baltic
are remotely accessed here.

Steady-state ecosystem model SANBALTS

This physical-biogeochemical marine model, called SANBALTS, computes and visualizes effects of how
changes in nutrient (nitrogen and phosphorus) loads affect conditions in all the major sub-basins of
the Baltic Sea. SANBALTS was used for the calculations of allowable inputs of nutrients for a healthy
Baltic Sea of the BSAP (HELCOMs Baltic Sea Action Plan) in 2007.

Time-dependent ecosystem model BALTSEM

Similarly to SANBALTS, this model simulates physics and biogeochemistry of the Baltic Sea, but with a
much higher spatial and vertical resolution. You can also study the effects of climate change in
scenarios of the future. This model is now used for the revision of the BSAP, to be finalized in 2013.

Fish modeling results

A model of the food web of the Baltic Proper than can be used to evaluate the effects of various
fishery management options, as well as effects of eutrophication and seals on cod, herring and sprat.
Catchment
The Catchment menu contains tools to explore a number of databases and a model describing
characteristics of the Baltic Sea drainage basin:

Riverine database
Includes tools that can be used to estimate riverine loads of nutrients to the Baltic Sea basins from
different drainage basins.

Catchment data

Here, we have compiled a large number of data, describing the distribution of human activities
generating most of the nutrient inputs that is within agriculture and sewage treatment from the Baltic
Sea catchments. These inputs to the drainage basins are then used in the watershed model (see
below). Most of these data originate from EU sources.

Watershed model CSIM
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The CSIM (Catchment Simulation) model describes how nutrient runoff from the Baltic watershed to
the Sea depend on drainage basins characteristics such as land cover, agriculture, populations, etc.
You can change these sources and explore the resulting effects on loads.
Economy

Cost minimization model
The model that is currently available here can be used to calculate minimum-cost solutions (for
measures within major sectors of society) needed to achieve a specific improvement in water quality
in any of the seven major Baltic Sea sub-basins. The data behind the model are not up to date, but the
model still shows, qualitatively, the principles regarding how we can reach a cost-minimization
solution for the Baltic.
Tools

The Expert mode allows you to display results with higher details compared to the default mode.
Documentation will lead you to web pages with further information about the models and Nest.

The rest of this manual is devoted to a detailed description and user manual of all the components of
Nest. Each section includes a list of references to studies where these components have been used.
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Atmosphere
This is an interface to emissions and modeled deposition fields of nitrogen and some other substances
for Europe. The data are accessed from EMEP (European Monitoring and Evaluation Programme) and
the Danish Eulerian Hemispheric Model (DEHM), with a resolution of 50 km x 50 km. You select the
data source by clicking on Atmosphere.

EMEP data
Atmospheric nitrogen depositions/emissions to the Baltic Sea used in the EMEP module originate
from the UNECE/EMEP emission database. For information about the modeled data, please go to the
EMEP web site. The data aggregations and averaging for 2000-2006 were compiled by EMEP to be
used by BNI for the calculations of the HELCOM Baltic Sea Action Plan. With EMEP data you have
several options:

Deposition data

If you choose Get deposition data from the EMEP databases, you can then select time periods and
various forms of nitrogen (oxidized or reduced, wet and dry, and total amounts), as well as
depositions of sulphur.
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Source-receptor data

The source-receptor calculations show depositions of nitrogen and sulphur from a particular country
on the EMEP grid. A description of these data and the calculations are found at
http://www.emep.int/SR_data/sr_grid.html.

In addition to total amounts, source-receptor deposition data for combustions, transports and
agriculture can be selected. In some cases you will receive a warning, such as this:
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This means that the modeled deposition fields may contain questionable data for some points,
especially at very low levels of the chosen variable. These data are then omitted from the calculations
of the total depositions over the requested areas, and only the areas that contain valid data are
calculated. When this warning is shown, some parts of the Sea, country or drainage basin are thus not
included. You can decide how large this omission is by comparing the calculated areas, using another
deposition variable that does not give this warning.

Blame matrix

From the EMEP model, you can get estimates of how much of the deposition that reach a particular
sub-basin originates from a specific country around the Baltic Sea. In addition, estimates are given for
depositions from ships on the Baltic, as well as from sources outside the region. These estimates can
be calculated for each of the different marine regions and watersheds, with the spatial resolutions
described earlier. If you click the option Show all sources, you will get the deposition from all countries
and other sources outside the Baltic region, on the polygon you select. These calculations are available
for all years since 1997, as well as averages for the periods 2000-2006 and 1997-2003. This example
shows the origin of BSAP oxidized nitrogen depositions over the Bothnian Bay, averaged for 20002006.

The check box Verbose tells the system to notify the user about any warnings, which can occur during
the calculation. Note that it can produce hundreds of notifications when data are not covering the
areas completely.

If you click the Save button, all blame matrices can be stored in a CSV-file that can later be read and
used by other programs, such as Excel. You can also right-click with the mouse on the table to save
only the selected content of the table.
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Emission data
This is the interface to the gridded data from the emissions database of EMEP with the official,
reported emissions from the countries for a particular year. Gaps in coverage are filled by EMEP.

NMVOC is the abbreviation for non-methane volatile organic compounds. NMVOC is also used as a
sum parameter for emissions, where all NMVOC emissions are summed up per weight into one figure.
In absence of more detailed data, this can be a very coarse parameter for pollution, e.g. for summer
smog or indoor air pollution.

DEHM deposition data

The Danish Eulerian Hemispheric Model (DEHM), is a atmospheric chemistry transport model that
covers the Northern Hemisphere with a resolution of 150 km x 150 km. It uses a two-way nested grid
for the European area with the resolution 50 x 50 km developed at the University of Aarhus in
Denmark (http://envs.au.dk/en/). These data have a higher temporal resolution (monthly) than the
currently available EMEP sets (annual or longer). A high temporal resolution could be useful, e.g. for
detailed budget calculation where the relative contributions of various nitrogen sources on a monthly
resolution are needed.

Analysis of data
The user can control visualization and data analysis using the sub-menu:
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Layers

Here you can select the layers that you want to see and use on the map:

 Graticule draws latitudes and longitudes, 10° apart on the map with the default scale (step can
vary with a map scale).

 Highlight. With this option the region you have chosen is brightly colored when you click on the
map.
 Data layer shows requested gridded data for the selected variable and time on the map.
Other options determine which areas can be used for integration of the requested data
 Country shows boundaries for all countries in Europe.

 Sanbalts polygons are the sea boundaries used by the SANBALTS model, which are also available in
Nest.
 Baltsem polygons are the sea boundaries used by the BALTSEM marine model, also available in
Nest.
 PLC polygons are the set of sea boundaries used in PLC (HELCOM Pollution Load Compilation).
 Seas. With this option, other seas in Europe (within the modeled domain) are available for
calculations.

 Watersheds. By default a total of 81 sub-drainage basin boundaries developed by Grid-Arendal
(http://www.grida.no/baltic/) are used. Note that you must deselect country boundaries if you want
to see watershed boundaries.

 Watershed 105 (EC, JRC, Ispra). Boundaries defined by the Joint Research Centre of the European
Commission at Ispra, Italy (see http://ccm.jrc.ec.europa.eu/php/index.php?action=view&id=23)
These 105 boundaries are currently used in the Watershed model CSIM in Nest.
 Watershed 117 (EC, JRC, Ispra, v2008).

Calculation
When you select the Calculation check-box, a panel appears over the map and you can then select to
calculate integrated depositions/emissions for various types of regions shown on the map. It is
important to make sure that the selected layer in the Calculation panel is also selected in the Layers
menu to ensure that the required polygons are drawn on the map. The Sanbalts and Baltsem polygons
correspond to the spatial resolutions of the Baltic in the two marine models available in Nest. Below
you see the panel of total annual nitrogen depositions on each Baltic Sea major basin, averaged for the

14

period 2000-2006, as calculated by EMEP for HELCOM. The calculations are performed using only the
gridded data that you have already requested using the Request panel.

You could get these results if you click Calculate for all. Alternatively, you can click on each region
(polygon) on the map. You can change the size of the calculate window by clicking on it and drag any
corner with the mouse. You can also keep the data and select another data set in the Request panel. If
you press Calculate for all again, these results are shown below the first compilations. If you don’t
want this, click the Clear history button. Some of the computations are quite time consuming and you
will see a warning window before you continue with the calculations.

The units for the numbers shown in the Calculation window are shown in the lower left corner of the
Nest main window.
Important! Do not use the Calculate for all option for Country. There are several reasons for this,
asides from taking a very long time; the deposition databases do not cover the entire territory for
many countries. For the Baltic region only the Western part of Russia is covered. You can find data
outside the Baltic regions for many European countries, and for e.g. Spain, outlying regions, like the
Canary Islands, are not covered. As you can see from the coverage below, you can get complete data
for many countries outside the Baltic Region. The EMEP coverage (shown here) is however larger
than the DEHM deposition fields.
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For countries, the best approach is to click on each country/polygon in turn and the results are then
shown in the Calculation window. You can thus get a measure for the Spanish mainland, but excluding
e.g. the Canary Islands.
You can also select an area with the mouse, surrounded by a clicked polygon only (usually an island or
a smaller watershed), within a greater region. In this example, we show a watershed adjacent to the
Gulf of Riga, with the resolution of the ISPRA watersheds from 2008 and total nitrogen depositions
from EMEP, averaged for 2000-2006.

16

All the data within the tables can be 'copied and pasted' into other applications (right-click on the
table), as well as saved as a CSV file.

Options
A palette is shown in a window on the map that can be used to change the color scheme of the
deposition/emission fields. Gridded values are interpolated for smoother graphical presentations by
default. You can deselect this in order to show gridded data in their original resolution.
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Baltic Sea
Marine distributed databases
With this module you can explore the hydrographic and geochemical conditions in the Sea. It is also
intended as a convenient tool for evaluating some of the data needed to develop and validate the
various marine models used in Nest.

The large databases, located at BNI as well as in several countries around the Baltic Sea, are regularly
updated as new data compilations become available on hydrochemical marine observations. These
data are presented in great detail. The purpose for doing so is to permit a free and open evaluation.

The left panel shows a map of the Baltic Sea. In the menu bar above the map you can chose between:

Layers
Here you select visualizing layers on the map. These are shown on the map and can also be used to
select data when you click within the boundaries. The different features are:
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Graticule
Places a 10-degree latitude-longitude grid over the map.

Stations

Shows the position of all hydrographic observations, requested and received from the databases.

Hydrographic polygons

The layer Hydrographic polygons is used to select an area for data request. You can request data for
two types of areas: a circle and a polygon. By default, there are a large number of circles bordering the
major monitoring stations in the Baltic. The user can click on any of these and the corresponding
name appears on the Request panel (in the upper right corner). In this panel it also possible to select a
Time period and request the data from a set of distributed databases by clicking the Request button.
This is the preferred method to select data from often visited monitoring stations, since the ships
cannot always make measurements at very exact, predefined coordinates each time. Here is an
example from BY15 in the Eastern Gotland basin. All the stations, within the circle and within the time
interval prescribed in the right panel, are shown on the map (enlarged here) as dots. The actual
measurements at a specific position are shown in the lower right panel if you click on a specific dot on
the map.

Country
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A map layer showing country borders, even those outside the Baltic region.

Topography

A topographic map is shown covering both land and sea. This map is hidden when the Country layer is
also selected. Water depths or land elevations at the point of the cursor are shown in the lower left
corner.

Areas

Open
Gives you the option of using a previously defined and stored circle or polygon on your computer.

New circle

You can define your own circle to retrieve all stations encompassed by the circle. Use the mouse to
place and define the size of the circle. You can then give it a name when you click on the map
anywhere outside the circle. When you have saved the circle, you can then click on it and retrieve data
within its borders.
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New polygon
You can define a user-defined region by creating a New polygon from the drop-down menu. Draw the
polygon by clicking with the cursor around the boundaries. Double-click on the last node when you
have finished and then click outside the polygon to name it in the window that now appears on the
map.

Save

Save allows you to save current areas (circles and/or polygons) on the local computer for later use
(see Open menu item).

Delete all areas

This menu item allows you to take away all areas from the map, predefined as well as those created by
the user.

Restore default

This option will place the predefined circles surrounding major monitoring stations on the map.

Set ‘HELCOM‘ polygons.

This option divides the Baltic Sea into the sub-regions officially defined by HELCOM and used in the
marine model SANBALTS.

Set polygons for the Baltsem model

You will then choose the sub-regions used by the BALTSEM marine model (for further details, see this
module below)
The three last items in the Areas menu (Add (clone) node, Delete node and Delete area) can be used to
change the shape of any polygon on the map or delete the selected area. Usually these items are
disabled (greyed out) and become active only when an area is selected for editing by a right button
mouse click. The selected area can also be moved with the mouse in editing mode.
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If the editing area is a circle the user can drag it by the center and/or resize it by dragging the outer
boundary.

Options

Marine databases accounts
Here you will have the possibility to include/exclude various hydrochemical databases. We have
managed to establish a number of agreements with institutions around the Baltic that collect marine
observations and maintain these databases. They can now be remotely accessed through Nest. Click
on this menu item and you will see them:
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By default, the first seven databases are publicly available.

BED (Baltic Environmental Database) is maintained and updated by BNI. We have here collected data
from various data providers over many years. BED contains data since 1877. According to the terms of
some data providers, access to some data still requires permission and a password, which can be
acquired through the data manager of BED.
The Leibniz-Institute for Baltic Sea Research (IOW), situated in Warnemünde, Germany, is responsible
for German monitoring in the Baltic, see http://www.io-warnemuende.de/. Data from the last three
years require permission and password.

The Shark database is maintained by the Swedish Meteorological and Hydrological Institute (SMHI). It
contains their own measurements but also many coastal observations collected by local and regional
Swedish organizations. Further information (in Swedish) is found at
http://www.smhi.se/klimatdata/oceanografi/Havsmiljodata
Sumppu is the marine database maintained by SYKE, the Finnish Environmental Institute. It contains
most marine monitoring data collected by Finnish institutes.
The Algabase database is also maintained by SYKE and contains data collected by Algaline.

ODA, is maintained by the Department of Bioscience and the Department of Environmental Science at
Aarhus University in Denmark.
Pivet is a marine database maintained by SYKE and contains data from coastal stations.

Set timeout

If you are using a slow Internet connection or expecting a very large amount of data (for big area
and/or long time interval), you may want to increase the default values here.

Criteria of station’s similarity: maximal differences

It may happen that the same observation is available in several databases. You can avoid including the
same data more than once by setting space and time criteria. By default, measurements that were
collected within the same minute, both in terms of coordinates (latitude, longitude) and time, are
treated as identical and duplicates are thus ignored.

Include coastal stations

Accessing data from the large HELCOM and BALTSEM sub basins (polygons) and depending on the
purpose of your query, you may or may not want to exclude coastal stations. In the graphical
presentation of the results, all observations within a specified depth interval are averaged. This means
for instance that coastal stations may bias the descriptions of concentrations for a particular sub-area.
Note that this option is applied only to data from the BED database where all stations have a flag for
coastal/offshore.

Vertical boundaries of the layers

For the graphical and statistical outputs, all observations within each depth interval are averaged. You
may change boundaries for these intervals here.
The Request panel
This panel is used to set parameters when you request data from the databases. A user can set the
area either from the drop-down list of areas or from the map using the mouse, and also set the Time
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period for the query. The Averaging interval (days), from which measurements are pooled and
averaged, cannot be set longer than 90 days.

In the figure above, we have chosen station BY15 (by clicking of the station on the map) and the time
period 1970-2000, with an averaging interval of 30 days. This means that monthly averages are used
in the graphical presentation (see below).

The middle panel shows a list of all stations extracted from the databases for the selected area. The
Server_id relates to the particular databases you selected to be included in the Options/Marine
databases accounts, described above. Each measurement is stored in the database with a unique id,
useful if you find e.g. dubious data that you want to discuss with the database provider. In addition,
information about position, date and name of the ship for the measurements are shown.

The Log panel in the bottom panel, below, shows how many stations/and individual measurements
that were extracted from each database, and how long time it took to extract these. The coordinates of
the rectangle for the area from where measurements have been requested are shown, as is whether
costal stations are included. You can also see how many duplicate stations were removed using the
criteria that were set in the panel for the marine database accounts.

The Station panel shows measurements at a selected hydrographic station. It is initially empty, but if
you select a station from the list above or from the map by clicking on the station’s position, the actual
measurements are shown. This particular station is now shown in red on the map.
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Time series
When you click on the Time series button, a new window is opened on the screen. Here you can select
which variable you want to display. With the Option button you can change the color scale and other
parameters of the graphical output.

White gaps are shown when the sampling interval is greater than the Max gap (days) value (by default,
one day longer than Averaging interval applied in the Request). You can change this value in order to
cover the gaps with linear interpolation for a smoother time-depth contour plots.
By resizing the window you can change the visual resolution of the time-depth image and get
additional information on the axes.
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With the vertical slider to the left of the depth axis, you can select a specific depth and plot the
temporal variations at that depth.

If you click on Data in this panel, the data behind the graph are shown.

You can right-click on these data to extract these into, e.g. an Excel file.

If you select Season you will get a graphical output (and table) showing the long-term monthly
averages for each depth interval
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If you use the vertical slider on this graph, you will get a line showing average values of the selected
parameter. In addition, box and whisker plots are shown (sample minimum and maximum, the lower
and upper quartiles and median). On any graph you can see the actual value of the selected parameter
corresponding to the current cursor position in the lower left corner of the Nest window.

If you had previously checked Trend calculations in the Request panel, you will get graphical outputs
showing results of a seasonal decomposition of the time series by LOESS, using the statistical software
R. For further details see http://stat.ethz.ch/R-manual/R-devel/library/stats/html/stl.html
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Steady-state ecosystem model SANBALTS
This coupled physical-biogeochemical model, called SANBALTS (Simple as Necessary Baltic Sea),
describes the effects of changing nutrient loads on environmental state in the seven major marine
basins. In Nest, the SANBALTS model is implemented in a steady-state mode that shows which trophic
state will eventually be established from changes in nutrient inputs. SANBALTS has been used in the
development of the eutrophication segment of the Baltic Sea Action Plan
(http://www.helcom.fi/BSAP/en_GB/intro/), where it was used for the computation of the maximum
allowable inputs of nitrogen and phosphorus that would secure marine environments “unaffected by
eutrophication” in the entire Baltic Sea. For further details, see the reference list at the end of this
section.
When you open SANBALTS the following window is shown:

To the left is a map of the modeling region with boundaries (blue lines) drawn between the basins. To
the right you will find two panels: the panel Forces show nutrient loads, and the panel Results show
the results from the model runs. A separate “floating” window appears on top of the main window, in
which you can select variables to be displayed on the map. This window can be placed anywhere on
the screen, depending on what the user finds convenient. Explanations for the displayed parameters
are usually shown in the lower left corner, below the map, when you move the cursor over an object.
You can analyze the model result in standard or expert mode by selecting this option in the upper
right corner of the Nest window and then obtain more details of model outputs.
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File

You can choose pre-compiled nutrient load data sets that are then used to drive the marine model
from the File menu, above the map. You can also compile (in the right top panel) and then Save your
own set for later use with the Read loads option. The PLC-3, PLC-4, and PLC-5 data sets are based on
data collected by HELCOM and EMEP for the Pollution Load Compilations corresponding to the
specific years 1995, 2000, 2006 or averaged over 2003-2007 (for details see HELCOM, 1998, 2004,
2011; Savchuk et al., 2012). Set loads according to BSAP are the allowable inputs of nitrogen and
phosphorus to each basin, evaluated with this model and used in the original 2007 Baltic Sea Action
Plan (see Anon, 2007). The Default loads are also based on HELCOM compilations of land loads,
averaged for 1997-2003, EMEP compilations of atmospheric depositions provided to HELCOM, and
Skagerrak concentrations of nutrients, averaged for 1997-02. Set loads for about 1900 sets inputs for a
more oligotrophic Baltic, before the expansion of human inputs from sewage, industry and
agriculture, described by Savchuk et al. (2008).
Forces
This panel shows the different sources of nitrogen and phosphorus: separated into River loads, Point
sources load, Atmospheric depositions and Loads from Skagerrak. A detailed description on how these
were derived can be found in (Savchuk & Wulff, 2007).

You can also make a detailed examination of these values by clicking on the little arrow to the left of
the table (>). You can then see the contributions from each country when you have selected these by
clicking on the label with the mouse. Return to the summary table by clicking on the other arrow (<)
to the left of the table.

The important interactive feature of this module is that you can set your own values for any nutrient
inputs at all levels of details, from particular country to the entire basin. This is done by doubleclicking in the corresponding cell, replacing its content with your number, and confirming the
replacement by pressing Enter.
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Results
After setting a specific set of nutrient inputs, either pre-compiled or using your own values, you can
provide some description of the loads in the Comment below the tables, which will be used as a
description of this model run. Press Calculate and wait until the corresponding steady state is
computed. The results can be seen graphically on the map as well as in several tables. In the default,
standard mode you can see only some general parameters. In Expert mode you can see all variables,
biogeochemical fluxes, and transport flows computed by the model, including concentrations in
sediments and fluxes between water and sediment. Note that you have to enlarge the Nest window to
see all columns simultaneously.
Variables

Here the results in terms on nitrogen (N) and phosphorus (P) concentrations for the seven basins are
shown (Baltic Proper consists of two boxes; above and below the halocline). The inorganic and
organic fractions of nitrogen and phosphorus are summarized. Water transparency (Secchi depth, in
meters) is calculated from empirical relationships with nutrient concentrations, either N (in bold) or
P. The left column shows water transparencies, estimated by the HELCOM EUTRO PRO project as
representing target levels in the Baltic Sea with acceptable environmental conditions. For further
details, see Anon (2007). In Expert mode you can see all fractions used in the model, including
concentrations in sediments.

31

Biogeochemical fluxes
Here you can explore most fluxes calculated by the model. The major internal source and sink terms in
the model are shown here. Units are, as usual in Nest, shown in the lower left corner. Nitrogen fixation
is a major internal source of nitrogen in some basins, and the fluxes seen here can also be seen as a
measure of the intensity of cyanobacterial blooms.

Half life, is defined as the time it takes for the basin’s annual primary production to develop half of the
eventual final, steady state response to altered loads, namely to achieve basin-wise values: PP0.5 =
PPdefault + (PPaltered – PPdefault)/2 = (PPdefault + PPaltered)/2. These PP0.5 values are zero for default
loads since the default initial conditions of the model are set to those found at steady state. More
interesting are the half-life values calculated when the model has been perturbed by altering the
loads, for example to the maximum allowable loads corresponding to BSAP. In this case, half-life’s for
the different basins vary greatly, from 5 years for Kattegat to more than 100 years for the Bothnian
Bay.
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Transport
These tables give you a detailed account of flows for both N and P between basins (Horizontal
advection), between the surface and the deep layer of the Baltic Proper, as well as the export to
Skagerrak. The advective flows are directed from “row” basin to “column” basin. You can use these
numbers, together with inputs (Forces) and finally, the internal source and sink terms
(Biogeochemical fluxes), to create detailed mass balance budgets of the Baltic and its major sub-basins.
In Expert mode you are able to obtain the transport data for inorganic, as well as for labile and stable
organic, fractions. Explanation for each value is, as always, available in the lower left corner of the
Nest window.

Network analysis
Here you have three additional panels for both nitrogen and phosphorus. In Contributions you can see
how much of the inputs to one basin reach a particular basin. The Total Input panel gives a detailed
account of the sources to each basin. The Total output panel gives an account of the exports from each
basin, by advection or by internal processes.

Visualizing the results
Visualization of the modeled results on the map in the left panel can be managed using the separate
window.
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Here, you can select any of the model variables, fluxes, and derived characteristics from the dropdown box. Click on the color scale to change it and set different minimum and maximum values for the
palette. Move the cursor over the different basins and see the actual values of the particular model
variable in the lower left corner. When you have run another simulation you can compare the results
in the map panel.

In the lower left corner you can see a comparison between the model runs. If you move the cursor
over the center of the Baltic Proper, you will get information on area extension of the hypoxic bottoms
and, with a click, the depth to hypoxic interface in the water column. You will also see the
contributions (in per cent) of nutrients (in this case nitrogen) originating as loads to the different subbasins for the two model runs (#0 and #1) by clicking on any of the basins. In this case, N loads to the
Baltic Proper contribute with 70 % and decrease to 58 % when the BSAP plan is implemented. Also,
the hypoxic area decreases by 15,046 km2 from 41,974 km2.

Other modeled characteristics (selected in the Draw window) give more information. In the picture
below, nitrogen fixation is shown, and by clicking on the Gulf of Finland you can see that the annual
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nitrogen fixation is eliminated here (decreasing from 18 100 tons per year to 0). The colors on the
basins show levels of the chosen variable. You can change these with the palette option in the Draw
window. All these results are also available in the tables in the Result window.
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Time-dependent ecosystem model BALTSEM
In the original calculations of allowable nutrient inputs for the BSAP agreement in 2007 the
SANBALTS model (Simply As Necessary BALtic Sea), available in the Nest system, was used. SANBALTS
computes steady-state results with a coarse horizontal and vertical resolution. These model outputs
are not easily verified against observations since measurements have to be aggregated to the same
resolution (basin-wide annual averages). Therefore, there is a need for a model that is both reliable
and convenient enough to be used for the revision of BSAP and implementation of the EU Marine
Strategy Framework Directive (MSFD), as well as for other managerial tasks included in an ecosystem
management approach for the Baltic Sea. To serve these needs, the model should be computationally
fast in order to allow multiple numerical runs necessary for finding and testing suitable distributions
of the water-protection measures. Furthermore, for building up credibility, necessary in the national
deliberations and international negotiations, it should also be publicly accessible through the decision
support system Nest. Such a model would allow any interested party to run and explore the hindcast
and scenario experiments, as well as visualize results. For these purposes, we have developed the
Baltic Sea Long-Term large Scale Eutrophication Model (BALTSEM), which captures the main features
of the Baltic Sea eutrophication, and now serves as the next generation marine model in the Nest
system.
You will see a map to the left and options for selecting forcing and display result in the right panels,
when you open this interface. The Baltic is divided into 13 sub-basins, as seen on the map.

In the right-hand panel, you can specify Meteorological forcing and Nutrient concentration in rivers.

Meteorological Forcing
Here you set the meteorological forcing for the model run. You can choose between the ERA40
reanalysis of present climate (Hindcast) and four climate model simulations generated within the
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ECOSUPPORT project which address responses to the IPCC A1B and A2 greenhouse gas emission
scenarios. A detailed description of these scenarios can be found in Meier et al., (2011a, b).
Meteorological forcing covers 1970 – 2006, 1850 - 2006 (Hindcast) and 1961 – 2098 (Climate
scenarios). Please note that global climate models cannot simulate the observed meteorological
conditions. Therefore the years 1961 – 1998 in the climate scenarios represent the statistical
characteristics of current climate, but not the sequence of actual weather events.

Nutrient concentrations in rivers
In combination with each set of meteorological forcing, you can choose between four load scenarios
and a hindcast, for details see Gustafsson et al. (2011) and Meier et al. (2011).

Period of simulation
You can select the entire period for a particular scenario or a shorter period within this interval.
Send task

Since the model run will take from several minutes to one hour on the host computer, it is useful to
supply an e-mail address, to which you will be notified when the simulation is ready. Actually you can
use whatever name you want as an account, but the notification will only be sent if the account looks
like a legitimate e-mail address. Below is an example of an e-mail received when a simulation is ready.
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The id (uuid) is the unique identifier of the model run, which you can paste into the Results box if you
want to analyze this model run or download all the data to your computer. Also shown is the time it
took to run the simulation, in this case 17 minutes and 41 seconds.
You may run several simulations, and each will have a unique id (uuid), but it is very useful to have
meaningful description as well in order to distinguish between the different runs.

You have to provide an account (e-mail address) to access all your modeling results. You can switch to
the Results panel when you have received the e-mail notification about available results.
Results
When the user provides his/her Account information (e-mail), the list of model runs appears in the
Result panel. Start by selecting one of the model runs. Clicking the right-hand mouse button opens a
window describing this run.

You can download a compressed (zip) folder to your computer and analyze the results locally, using
your own software, by providing your uuid. You can also share access to your results with someone
else who is also using Nest if you provide this information. It is important to note, that this feature is
for advanced users since there are many files in the zipped archive with very detailed, not very
intuitive information.
You can also visualize some of the results within Nest by clicking on the map (over one of the subbasins) and then select Pelagic or Benthic variables or fluxes for visualization.
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In this case, the user has selected Pelagic variables for the Baltic Proper. A new floating window
appears on the screen and all associated variables will be downloaded to the local computer. The
drop-down list allows you to select the variable you want to display.

Note, you can open several windows for the same and/or different basin(s) from the same and/or
different numerical experiments, resize them, and move them around the entire computer screen. In
the example below, the user has selected Benthic fluxes in the Gulf of Finland from hindcast simulation
for 1970-2006
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Data
The Data tab shows a contour plot of the variable you have selected, by default for the entire time and
depth interval. The user can then analyze/display the data in similar ways as in the Distributed marine
databases module of Nest. As usual, you can see the actual numbers in the plot in the lower left corner
of the Nest main window, by moving the cursor over the plot.
You can change the color scale and depth range in the Options/Draw tab.

The Options/Data tab allows you to select the time period for the plot as well as averaging (days)
interval. The model data are saved with a 5-day interval and you can then choose an averaging
interval for outputs, used in the plots.

If you chose the Data tab in the graphics window, you will see the actual numbers. By right mouse
button clicking on the table, you can, as usual, copy and store these values.
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Season
You can also evaluate long-term seasonal (monthly) averages, either as contour plots or, by using the
slider, as XY-graphs of simple statistics for a specific depth: average (line) and box-and-whiskers
(minimum and maximum, 25% and 75% quartiles, as well as median).

Profile
This panel shows the simulation statistics as a table to the left and as a graph to the right, aggregated
to specific depths and minimum, 25%, 50%, 75% and maximum. The red line shows mean value while
the green line represents the median (50%).
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Fish modeling results

In this module, you can explore the effect of various fishing strategies on future stocks and yields of
the three major commercial fish species in the Baltic proper: cod, herring and sprat. It has been
argued that the drastic changes that have occurred in fisheries are not caused by fishing only, and
with this model you can also study the effects of seal predation and of changes in primary
productivity.
There are two major panels:
Scenario
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In the Fish panel, you can select different fishery management options for sprat, herring and cod.
Explanations will appear in the lower left corner when you move the cursor over the options. The
status quo situation for year 2000 is default for all stocks and seals, as well as for the primary
productivity level of the Baltic.

When you select the Productivity scenario options, Status quo or model runs with conditions of the
early 1900 level can be chosen, which as much lower productivity and/or higher oxygen levels
compared to today (you can find the same scenario in the SANBALTS model). You can specify Spring
phytoplankton, Other phytoplankton and Cod reproductive volume separately.

Results
When you press Request, the model run that you selected in the Scenario panels will appear in the
Result panel. You can request several scenarios, corresponding to different combinations of driving
forces, for further inter-comparisons, and these results will appear in the Runs panel, as well with
separate ID and different color.

If you select Variables, you can see the nine default variables. All the variables in the model can be
shown if you choose Expert Mode from the Tool menu.

You can click Clear selection to clear all variables, and thereafter check the boxes of only those
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variables that you are interested in for your model run before you press Draw. By clicking on a
colored box, a color editor will appear that allows you to change color of a variable.

When you select Draw in the Results panel the temporal variations of the variables that you selected
will appear in the left hand panel.

In the lower left corner you will see the values corresponding to the position of the cursor. The actual
values for all the variables are shown in the table below. Select and save the whole, or a part of the,
table for use in other programs, for instance Excel, by 'right-click' on it.
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The module allows you to analyze several model runs. In the figure above two tabbed panels (#1 and
#2) contain results from two model runs. A user can draw several variables of one model run, or one
variable for all model runs (see the two figures below). The button Show runs/Show vars switches
between those modes. The button Show rel. value/Show abs value changes the form of data
presentation (relative to initial value (1974) in per cents or absolute value in tons).
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The actual observations, used to calibrate the model, are then shown for the period prior to 2000.
Select another fishery management option in the Scenario panel, and the result will be shown by
another color in the Result panel.

The graph will then show both scenarios in the graph panel:

Again, you can select different variables to display by selecting them from the panels below the graph.

You can also go back to the Result panel under Variables in Expert mode and select additional variables
that were not initially included. You can also deselect some of the initial variables, by clicking on the
appropriate check boxes.
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The panels below the graph will then display your new selection of variables.

You can display all variables for a particular run by selecting the tabs for these below the graph, after
selecting Show runs.

Alternatively, you can see all runs for a particular variable by pressing the same (right) button again
and it will display Show vars.
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In both these modes you can show absolute and relative values for all variables. You can also go back
to the Scenario panel and add more model runs.
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Catchment
Riverine database
This interface describes freshwater runoff and nutrient loads for the period 1970-2000 in
considerable detail: from single rivers to drainage areas of individual marine basins to the entire
Baltic Sea.

The map to the left shows the entire drainage basin with 81 sub-drainage basin boundaries. By
clicking on any of these (the color will then change) you can select data on loads for this particular
sub-basin from the database when you downloaded data from the Request panel.

The right side panel contains three sections. The Request panel at the top allows you to select a time
interval between 1970-2000 and request data from the database. These data were originally compiled
by Stålnacke (1996) and later extended by BNI. You will see the observations as a time series graph in
the middle when you have checked a particular variable.
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By default, you will get and see annual loads of the variables. If you choose Expert mode in the Tools
menu in the menu bar of the Nest system, you will see the results with monthly resolution. You can
also change the vertical scale in the Options menu, as well as presenting the results in absolute
amounts or as concentrations.

Thus the total inputs of runoff (fresh water) for the entire Baltic, together with total nitrogen (TOTN)
load, would look like this.

You select the variables to be displayed, but also the region of the Baltic, in the tree below the graph.
Here you can select the sub-basin, country and even data for a particular drainage basin. In this case
the Vistula basin is shown (Baltic Proper, Poland, nr 85). The Baltic drainage basin is divided into 81
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sub-drainage areas, as developed by Grid-Arendal. The chosen drainage basin is highlighted on the
map.
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Catchment data
This is an interface to spatially gridded data describing sources of nutrients in the drainage basin of
the Baltic Sea. Some of these loads will eventually reach the Baltic Sea. When you open the interface
you will see the following window:

There are three menu boxes for this interface found on the second row of the menu bar, as well as a
Query window that can be placed anywhere on the screen.

Layers
Here you can select sets of layers that you want to see and use on the map

Where:

 Graticule draws latitudes and longitudes, 10° apart on the map in the default scale.

 Highlight allows highlighting the area you have chosen when you click on the map to calculate an
integral values for this area (see Calculation).
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 Watersheds of the Baltic. By default a total of 81 sub-drainage basin boundaries, developed by
Grid-Arendal, are used.

 Watershed 105 (EC, JRC, Ispra) Boundaries defined by the Joint Research Centre of the European
Commission at Ispra, Italy. These 105 boundaries are currently used in the Watershed model used in
Nest. You must deselect previous watershed layers in order to see these watershed boundaries.
 Watershed 117 (EC, JRC, Ispra, v2008). The current, officially defined version of watersheds, also
developed at Ispra.
 Country layer shows boundaries for all countries in the world.

 Exclusive Economic zones. As defined by the United Nations, these stretches from the seaward edge
of a state's territorial sea out to 200 nautical miles from its coast. When an overlap occurs, it is up to
the states to delineate the actual boundaries. The boundaries for the Northern seas, used here were
extracted from the KnowSeas project. The reasons why these are included as a boundary are
explained below.
Query
This movable window is always shown on the screen. Here, you have three major data categories to
select from, i.e. Agriculture, Animals, and Population (all in a 10x10 km grid).

The Agriculture option includes nitrogen (N) and phosphorus (P) fertilizer and manure applications
and crop type data for the year 2000. The data has been compiled by the European Commission’s Joint
Research Centre at Ispra.
The N and P mineral fertilizer application, as well as the N and P manure application, only covers EU
countries. However, the data set “N mineral fertilizer application (reduced for Poland with 40%)”, is
expanded to partly cover Russia and Belarus and is corrected for Poland, see details in the “NANI
toolbox” section 3.3.
The Crop data covers the entire Baltic drainage basin, including Russia and Belarus.

The Animal option includes numbers of cattle, pigs, poultry etc. Animal classes are of two main types.
The classes from EuroStat are more specific, e.g. “Piglets with a live weight of less than 20 kg” etc., and
cover only EU countries. The more general types, e.g. “Pigs” etc., cover the whole Baltic catchment.
Data on animal numbers for the EU countries were calculated as median values for the years 20002005, except for NUTS areas in Denmark where 2009 values were used.

Data were derived from EUROSTAT on NUTS level 2. The NUTS classification (EU nomenclature of
territorial units for statistics) is a hierarchical system for dividing up the economic territory of the EU
for collection and harmonization of regional statistics.
For Belarus animal data were derived for 2008 from regional statistics on a Voblast (province) level
and from national statistical yearbooks.
For Russia animal data for 2009 were derived from regional statistics on an oblast (province) level.
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For some oblasts that were lacking data, animal numbers were calculated based on animal number
correlations with rural population in neighboring oblasts where data is available.

The Population option includes total, urban and rural data for the year 2005. These were derived from
the HYDE database, developed under the authority of the Netherlands Environmental Assessment
Agency. The data on a 5' x 5’ latitude/longitude grid were downloaded and redistributed into a 10x10
km grid.
Also included in the Population option are the number of people connected to different levels of waste
water treatment (primary, secondary and tertiary), as well as the number of people NOT connected to
any type of waste water treatment. These are based on calculations done by BNI.

More information regarding the population, animal and crop data can be found in Hong at al. (2011).
It is possible to create various detailed maps by altering the Nest window, magnification, and the color
scales. Here are a few examples, using data on N mineral fertilizer applications from Ispra.
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Calculation
A new window appears when you click on this item in the menu. This window can, according to the
users convenience, be placed anywhere on the screen.

Here you can calculate total amounts of the variable you requested in the Query panel for different
polygons on the map (watershed, country, etc.). Remember to select the same layer under the Layers
menu. It is important to understand that the gridded data, with a resolution of 10 x 10 kilometers,
often varies compared to the much higher resolutions of the boundaries of countries or watersheds.
For instance, if you select Lithuania (by clicking on the map (highlighted when the calculation is
done), you will get a warning:
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By examining the (enlarged) map, you will understand why:

Due to the coarse resolution of the gridded data, tiny proportions in the southeast region (Dieveiskés),
as well as the peninsula bordering the Curonian Lagoon, are not covered (hence the warning). You
have to judge yourself whether these omissions are important or not. In other cases, these omissions
are correct; the drainage basin to the Baltic does not cover the entire country, such as for Russia and
Sweden, and you will get the same warning.

Thus, it is important to understand the fundamental logic and limitations of extracting information
from these GIS calculations, where different data sets have different resolutions. In the example above,
parts of the grid cells lies outside the country borders in regions where there are no data (the Sea, in
the Kaliningrad region and in Belarus). This means that the calculated total amount is lower than the
‘true’ value. You must yourself judge whether these calculations are reasonable approximations by
inspecting the map and the magnitude of the values found in these grid cells.
These omissions may create underestimates for some parameters, in particular those regarding
populations. These data cover the entire drainage basin, including non-EU countries. Using the
example of Lithuania, you can see a complete coverage of the country. However, due to the size of the
grid cells, some people living close to the Sea end up in the Sea (in the Klaipeda region). This could be
a serious underestimate for some countries, since many people live near the coast! However, this can
be corrected by performing a separate calculation, summing up also the people living in the Exclusive
Economic Zones (by using this layer).
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The total population is then 3 232 810, of which approximately 20 000 people ‘live in the Sea’ in this
case.

Options

By selecting Show palette, a palette is shown in a window on the map and it can be used to change the
color scale of the data shown. By default gridded values are not interpolated for graphical
presentations. You can select this in order to show interpolated fields.

Literature
Hong, B., D.P. Swaney, C. - M. Mörth, E. Smedberg, H.E. Hägg and C. Humborg. 2011. NANI/NAPI
Calculator Toolbox version 2.0 documentation: Net Anthropogenic Nutrient Inputs in Baltic Sea
catchments. BNI technical report series, No 3.
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Watershed model CSIM
Measures to reduce loads to the Sea primarily occur on land. A model describing nutrient loads and
how these are affected by changes in hydrology, land use including agriculture and sewage treatment
is therefore necessary. The watershed model used in the Nest system here is the CSIM model of Mörth
et al (2007), simultaneously simulating the nutrient land-sea fluxes from all 105 major watersheds
within the Baltic Sea drainage area. This was used in the original BSAP calculations to calculate the
effects of improved sewage treatment in the different countries on nitrogen and phosphorus loads.
When you open up this interface you will see the following window:

To the left is a map of the Baltic region with the drainage basin, split into 105 sub-drainage basins (the
same as in the Catchment data interface). To the right there are two panels; the top is used to set
Forces, Drainage basin properties and Countries emissions. The lower right panel will show Result from
the calculations. A free-floating Palette, that can be placed anywhere on the screen, is also shown.
Forces
This panel can be used to change (in per cent) precipitation, air temperature and land use, for each of
the nine countries bordering the Baltic Sea, as well as for each marine basin.
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You can change, within a pre-defined interval, the default values by clicking on any of the numbers in
the table.
Properties of the drainage basin
Here, you select any of the drainage basins on the map, by clicking on it, and a table is displayed
showing the properties of that region. In the upper right corner you can choose between additional
variables.

Below examples of the initial properties for the Neva drainage basin are shown.
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These are the default values. You can change any of these by typing in new values, except for land
cover, which is static.

Countries emissions
Here you can inspect and change a number of country specific variables, selectable in the upper right
corner of the window. Each variable is explained in the lower left corner of the Nest main window.
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Any of these values can be changed before you run any calculation, by pressing the Calculate button
found below the tables.

Calculate
Results, in terms of nutrient loads, are shown in the lower panel. Please remember to give the
simulation a name in the Comment panel, before you press Calculate. The results can then be exported
and used as nutrient inputs to the marine model (SANBALTS). If you press that button, the interface of
the marine model is opened with the data you just calculated here. The results are shown in the
marine model SANBALTS as riverine loads. Coastal points loads are set to zero, since this model
doesn’t distinguish between coastal point sources and riverine loads.

You can expand the resolution of the loads to drainage areas of marine basins or to singe river
catchments in the same manner as in the Riverine load module. Just press the Σ icon.
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To the right, the map will now display model-calculated concentrations of dissolved and organic
nitrogen for all the 105 catchments, expressed per unit area or per capita. You can also change the
color palette here.

Colors on the map represent the modeled results, which can also be seen in the lower left corner of
the Nest main window by moving the cursor over the map.

Literature
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D.P., Rahm, L. 2007. Modelling riverine nutrient transport to the Baltic Sea – A large-scale approach.
Ambio 36:119-28
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Economy
Cost calculations
The costs for reducing nutrient loads to the Baltic are indeed large. However they are highly variable
between different measures and between countries. It would undoubtedly be possible to reduce the
total costs if the measures with the lowest costs were chosen. This cost calculation module provides a
number of alternatives for calculating the most cost effective way to achieve a desired improvement in
water transparency (Secchi depth, presently the only environmental target included). The basic logic
is the following:

You are, in this module, primarily working in Target mode, i.e. you first set an environmental target an improvement in water quality for one or several marine basins. You may also set restrains on what
measures and what countries (and sub-drainage basins) that should be included. The model then
calculates a minimum cost solution to reach this objective. You also have the option to change various
parameters of the model and investigate whether these will affect the results.
The minimum-cost solutions are calculated from cost estimates of a number of different mitigation
measures in a total of 23 catchments around the Baltic Sea, aggregated to a country-per-basin level.
This module includes options to change various parameters and to exclude measures, as well as
countries or sub-drainage basins in scenario analyses. However, the data behind these calculations
are in many cases outdated and originate from the 1990-ties. Still, the model shows, in a qualitative
sense, the effects of using cost minimizations for the distribution of measures between countries and
stresses the strong interconnectivity of the regions.
When you open the panel, you will see the following window:
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To the left is a map showing the 7 major sub-basins of the Baltic Sea. To the right are panels for
Targets and Measures, followed by a panel for Results below it. Please note the Warning: Some data
behind this model are outdated!
Targets
Start by selecting a desired improvement in water transparency in one (or several) of the Baltic Sea
basins. You do this by either typing a value of desired improvement into the cell, or by selecting the
cell and then moving the slider to the far right. In the example below an improvement in the water
quality in the Gulf of Finland by 1 meter has been selected.

Measures
Choose the combination of measures you would like to explore by deselecting the measures you want
to exclude. These are aggregated in 7 major groups:
 Fertilizer use

 Sewage reduction
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 NOx reduction

 Wetland restoration

 Change of N spreading time
 Livestock reduction
 Land use

You can also choose whether these measures should be taken in all countries around the Baltic Sea, or
just in one or more countries. Countries, or specific sub-basins of that country, can be excluded by
clicking and then deselecting all or some measures. In this case, fertilizer use and sewage reduction
from Russia to the Gulf of Finland are excluded:

Calculate
If you click on the Calculate button, the cost-optimal solution is calculated. The Countries panel will
show the costs distributed between countries, as well as the reduction in loads of nitrogen and
phosphorus, expressed as per cent of current loads.

When you switch to the Sea regions panel you will see concentrations of nutrients, water transparency
(Secchi depth) and improvements for all basins. Notice that conditions, in terms of water
transparency, are improved in all basins, not only in the Gulf of Finland.
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In the map panel, you will receive additional information. If you click on a basin, a table appears that
shows nitrogen and phosphorus reductions to that specific basin.

The blue bars show reference values (dark blue) and improvements (light blue) in water transparency
in each basin (graphical presentation of the information from the Sea regions panel). The pie charts
show where and how large the costs for nutrient reductions are. The size of the circles reflects the
relative contributions to total costs. If you click on a country or a pie chart, you will see the
distribution in M€ for different measures, in the minimum cost solution. In this case, 55% of the total
cost will occur in Russia, with 16.1 M€ for additional reductions of nitrogen from sewage.

Please note that if you select too radical improvements it may generate infeasible solutions if the
desired improvement cannot be achieved without measures being taken within a certain country or
sector(s). For example, a large increase in transparency in the Gulf of Finland cannot be achieved
without measures being taken in Poland. You will also receive a message if you choose an
unrealistically large improvement of water transparency.

A more detailed choice of the parameters used in various measures can be found when you select
Expert mode in the Tools menu (on the upper row). You will then see a third panel called Parameters
in the Input Data panel.

The Parameters panel gives you the option to change a large number of parameters for all 23 subdrainage areas. In the example below you can see the parameters that you can change related to
Agriculture, after selection of this in the drop-down menu.
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The meanings of all these parameters are explained in the lower left corner under the map.

In the File menu you have the options to store and read your own set of parameters from a file, or
restore the default parameters.

In the Tools menu you can also see the effects of using the same parameter values for the larger
regions, without having to key in each value separately. You select this by using Set equal price.

You will then see a new panel where you can select prices and regions as shown below:

It is also possible, in the Tools menu, to change which nutrient, nitrogen or phosphorus, that will affect
water transparency (and productivity) the most when you change the loads.
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You can also set a maximum transparency, i.e. you will limit the user possibility to increase these
values to be within reasonable bounds; it is not possible to reach water transparencies similar to
those in the blue Mediterranean Sea!

The basic assumption used in this context is that transparency is a function of the concentration of
total nitrogen in all basins, expect for the Bothnian Bay, where it is determined by the concentration of
phosphorous. You can change these assumptions using the ”Transparency rule…” under Tools. The
empirical relationships between concentrations of total nitrogen and water transparency have been
determined using data from many years of monitoring in the Baltic Sea. Please also note that the
values of water transparency given in Nest refer to the annual average transparency of seawater in
the open sea.
It is also important to note that the concentrations of nitrogen and phosphorus are calculated
independently of each other, which is of course not the case in nature. A linking of the two occurs in
the marine model modules but is not yet implemented in the Cost model.
You will often see reductions in both N and P, since many measures will reduce the load of both
nutrients.
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Feedback from users of the Nest system is essential and very welcome!

Please, contact Fredrik Wulff (fredrik.wulff@su.se) or
Alexander Sokolov (alexander.sokolov@su.se)

at the Baltic Nest Institute, Stockholm University Baltic Sea Centre
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